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Introducing VPN Tracker 365

Welcome to VPN Tracker, the leading VPN client on Mac. Whether you are new to VPN or a seasoned VPN guru, this manual will help you get
started with VPN Tracker.

New to VPN Tracker?

e Install VPN Tracker and start your free demo in — Getting Started

System Administrators and IT Departments

e (Connect to your existing VPN or set up a VPN from scratch in

— Getting Connected

e Setup VPN Tracker for others in — Exporting Connections

Where to go for help

e Questions about a specific device or protocol? Refer to our for device- or protocol-specific setup instructions
e Questions about VPN Tracker 365 plans or functionality? Refer to our extensive list of

e Problems with setup or in need of advice? Get in touch with our


https://www.vpntracker.com/us/compatibility.html
https://www.vpntracker.com/us/support.html
http://equinux.com/goto/sendtovpntracker/contact/en

VPN Tracker 365 Plans

We offer four different VPN Tracker 365 plan tiers to fit your requirements:

VPN Tracker 365 VPN Tracker 365 9} VPN Tracker 365 VPN Tracker 365

Check out our for a full overview of what each plan offers.

Regardless of the plan you have purchased, you can always download and use the same copy of the VPN Tracker application. Your license will automatically unlock all the
features included in your plan.


https://www.vpntracker.com/us/editions.html

Installing VPN Tracker 365

You can always from the VPN Tracker 365 website. Once downloaded, move VPN Tracker 365 to your Applications folder.

@ When you first launch VPN Tracker 365 on your Mac, you will be prompted to install
Step1of 2 ' Py the VPN Engine and authorize the System Extensions that lets VPN Tracker’s VPN

jon Blocked / \ . . .
i meme | ) Engine access network packets and do its thing.
load new system extension(s). If you —

want to enable these extensions, open
Security & Privacy System Preferences.

This step needs to be done on your Mac with VPN Tracker in your Applications folder
and can't be carried out remotely (i.e. via Remote Desktop.)

OK

Open Security Preferences

< i Security & Privacy

General  FileVault ~ Firewall  Privacy

Alogin password has been set for this user  Change Password...
Vv Require password immediately  after sleep or screen saver begins
v Show a message when the screen is locked | Set Lock Message...
v Disable automatic login
Use your Apple Watch to unlock apps and your Mac

In the next step, you'll be prompted to open System Preferences — Security &
Privacy. Here you need to “Allow” VPN Tracker 365's System Extension.

Allow apps downloaded from:
App Store.
* App Store and identified developers

System software from application “VPN Tracker 365" was blocked
from loading.
\lck the lock to prevent further changes. Advanced... ?

Finally, you will also need to allow VPN Tracker 365 to add VPN configurations.

VPN Tracker 365" Would Lke to For Enterprise rollouts via MDM, you can also pre-approve the
onfigurations
Al rtvorc sty o i Wac may bo VPN Tracker Kernel Extension using a special profile. Our Team IDs are CPXNXN488S

and MJMRT6W])8S.


http://vpntracker.com/download

Your VPN Tracker 365 account

Accessing your VPN Tracker 365 account is quick and easy. You can start using your plan in a few seconds over any internet connection.

How many plans do | need?
VPN Tracker 365 is licensed per-user, so each user that wants to use VPN Tracker needs their own plan.
Testing VPN Tracker

If you want to make sure VPN Tracker 365 works with your connection and meets your expectations before purchasing, you can test the demo version for free. This will give you
access to all VPN Tracker Pro features (except exporting connections). All you need to do to get started is create a free account:

L IO
Grace Miiller
[ Get VPN Tracker | Create a connection
Offices
&~
VPN Tracker
| CoMPANY CONNECT]
Connect to your company or personal VPN with our step-by-step guides. Surf securely and privately. Avoid internet restrictions. Connect to VPN Tracker
World Connect.
Create a Connection. Choose destination...
<& Connection Checker
192.168.40.1 - 18:b1:69:94:05:00 ¢+
@ wpsec
@ openven
@ soriewarLssL
Get started...
+ & <]

If you set up your VPN connection during your free demo period, VPN Tracker 365 will keep all your settings and details once you purchase a license.

To purchase a license: Visit


https://www.vpntracker.com/buy

Getting Connected
VPN Crash Course

Is this your first time working with a VPN? Read this chapter to get you up to speed.

VP..What?

VPN Tracker allows your Mac to securely connect to another network over the Internet. Even if your office is located in San Francisco and you're on a business trip in New York,
you can work with your applications and files, as if you were in your office.

This Mac Internet VPN Gateway Remote Network
192.168.213.192 vpn.example.com 192.168.213.0/24
S

How does it work?

As the name implies, VPN Tracker uses VPN (Virtual Private Network) technology to create a connection between your Mac and your remote network. And unlike normal Internet
connections, a VPN Tracker connection is encrypted. Think of a VPN as a highly-secure tunnel through the Internet, your very own "secure line" to your office.

In order to use a VPN, you'll need your Mac running VPN Tracker on your end of the connection. On the other end of the connection (the remote side), you need a VPN gateway
that accepts your incoming VPN connection.

Once you have set up your connection in VPN Tracker and on the device at your remote location, you are ready to connect and start working remotely using your normal tools
and applications.



What do | need?

To create a VPN connection from your Mac, you need three things:

e VPN Tracker 365
e An Internet connection
e AVPN gateway

If you're reading this, you probably already have VPN Tracker and an Internet connection for your Mac. So what about a VPN gateway?

VPN Gateway

A VPN gateway is a hardware device (or in some cases specialized software running on a regular computer) that accepts incoming VPN connections, creating a secure tunnel
between its local network and your Mac. In most cases, a VPN firewall or a router with built-in VPN capabilities will act as the VPN gateway.

If there are existing VPN users in your organization you probably already have a properly configured VPN gateway. If not, don't worry - check out for some tips on
what to look for when buying a VPN gateway.

What kind of VPN connections does VPN Tracker support?
VPN Tracker 365 supports all industry standard VPN protocols:

IPSec
OpenVPN
L2TP

PPTP
SonicWALL SSL

Our can help you get started with setting up a connection for your chosen VPN protocol.


https://blog.equinux.com/2020/04/best-vpn-gateway-for-remote-work/
https://www.vpntracker.com/us/compatibility.html

The Big Picture

Add a New Connection

e  Click the button in the lower left hand corner of the VPN Tracker 365 window and select “"New Company Connection...”

New Company Connection...
New World Connect Destination...
New VPN Shortcuts

You will see a list of device profiles. We have device profiles for all the VPN gateways that VPN Tracker has been tested with:

O Al World Connect

VPN Tracker lConnscﬁun Name:

My VPN Connection

UCEIZH Psec/L2TP / OpenVPN/ SSL | PPTP

Choose your home or

n  Amazon AWS

7 Asante Asante * t
P astama Astaro " ’*
AM M k i

Qi checkPont Check Point *l
P

bl
cisco’  Cisco
s Cisco Meraki
e i
Lo

Cisco Small Busi... »

cuawvister Clavister

cancel

e Select your VPN gateway from the list. If your VPN gateway is not listed, click the button “Use custom device profile”.
e C(lick “Create” to add the new connection



Basic Settings

Let's take a closer look at the essential settings that VPN Tracker 365 needs to connect to your VPN gateway. Depending on your device, some settings may not be shown.

Connection lcon
Customize the icon by
dragging an image onto the
default icon, or choose

“Edit > Choose Image..." for
a new icon.

Device Profile

C: ion Name

@ NETGEAR VPN

Basic  Advanced

NETGEAR

Actions

Nightly

Done

Connection Name
Click to change the name of

NETGEAR VPN

Click to change the device profile.

VPN Gateway

Connection based on

Enter the public IP address
or host name of your VPN
gateway, e.g 203.0.113.48 or
vpn.example.com

Authentication

* NETGEAR FVG318

Configuration Guide

your connection.

Configuration Guide
Click to access the device-

specific configuration guide.

Network Configuration

Choose whether to use a
pre-shared key, certificates
or hybrid mode for authen-
tication. Most VPN gateways
use pre-shared keys.

Identifiers —,

Select the type and enter
the local and remote identi-
fiers.

Note: The identifiers need to
be entered in reverse, e.g.
“local”in VPN Tracker is what
is configured as “remote” on
your VPN gateway.

Local

Remote

DNS

Manage Team & Plans...

Team Options

Fully Qualified Domain Name (FQDN)
Fully Qualified Domain Name (FQDN)

VPN ?
Network C:
Protocol  IKEV1
Topology Host to Network ?
Local Address 2
(+] Remote Networks ?
Authentication  Pre-shared key B + Password not saved

=
.

Select manual configuration or one of
the automatic configuration options
(not available on all devices).

Extended Authentication

VPN Tracker will prompt you

for username and password

if your VPN gateway requests
? Extended Authentication

? (XAUTH).

DNS

Use Remote DNS Server

Takes you to my.vpntracker.com where
you can manage your team’s settings.

VPN Tracker can use a DNS server
on the remote network over VPN.
It is not necessary to configure
remote DNS right away, you can
always do so later.

Export Settings... Export...

Export Options
Export your connection to share with
team members or colleagues.
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Advanced Settings

You likely won't have to modify any settings on the Advanced tab, unless:

e your device uses different settings than the factory defaults and/or the settings proposed in the configuration guide, or
e thereis no device profile for your device in VPN Tracker

In both cases, the goal is to have VPN Tracker's settings for Phase 1 and Phase 2 match exactly what is set up on your VPN gateway.

Completing Setup

When you're done configuring your VPN, click the ,Done” button on the upper right corner to leave edit mode.
It is not necessary to leave edit mode to save the connection or to connect to the VPN. If you make changes while the VPN is connected, reconnect the VPN to apply them.

Now that you have a basic idea how to set up a connection in VPN Tracker 365, you're ready to apply it to your specific situation.

Did you receive a VPN Tracker connection from your administrator?

e  The next chapter shows you how to use the connection in VPN Tracker.

11



Importing Connections

Find out how to import a connection that you have been given by your IT department or VPN administrator.

Import Your Connection(s)

e Locate the connection in Finder and double-click it. Or open VPN Tracker and choose “File > Import > VPN Tracker Connection...” from the menu:

@& VPN Tracker 365 IHE Edit VPN Tools View Window Help

[ JON New >

Grace Miiller -/ Pssal e o
@ VEN Tracker 365 VIP ) VN Tracker onnectlan...
VPN Tracker World Cor  Migrate > Cisco VPN Client Connection (.pcf)... onnection Safe
~ Export... HBE System VPN Connections...
Q | OpenVPN Connection...

Close Window  3W  1,nnelplick connections...

VPN Shortcuts

VPN Shortcuts

e You will be asked for the import password. If you don't know the import password, please ask the person who gave you the connection.

Replacing Existing Connections
If you already have the connection you're about to import, you'll be asked whether to replace your existing connection, or if you would prefer to add this connection as a copy:

Replacing a connection
If your new connection replaces your existing connection, click “Replace”. Your existing connection will be overwritten.

Adding a copy

If you would prefer to keep your existing connection and import the new copy, click “Add Copy”. You'll find the imported connection further down in your connection list. It will
have the word “copy” appended to its name, e.g. “Office copy”.

Replacing existing VPN Shortcuts

Connection files can also include VPN Shortcuts. If the included VPN Shortcuts already exists, you will once again be asked whether you would prefer to replace your existing
VPN Shortcut or add a new VPN Shortcut as a copy.

12



Connecting to Your New VPN

When you're done setting up your VPN, you're ready to connect. To test your VPN, go to a location outside of the network that you want to
connect to.

Connecting
Click the on/off slider to connect the VPN:
Offices oo
@ SecureCorp 3
P o @
If you are using VPN Tracker 365 for the first time with your current Internet connection, will test your connection. Wait for the test to complete.

If prompted, enter your pre-shared key and Extended Authentication (XAUTH) username and password.

Connected?
Connecting may take a couple of seconds. If the On/Off button turns blue that's great - you're connected!

Continue with the next chapters to find out how to use VPN Tracker 365 and your VPN connection effectively.

Problems?

If there is a problem connecting, VPN Tracker will give you helpful advice and troubleshooting tips. To learn more about troubleshooting VPN connections, visit the chapter —
Troubleshooting

13


https://www.vpntracker.com/us/features.html%23connection-checker

VPN Shortcuts: Your VPN Cockpit

Shortcuts give you one-click access to the files, documents and applications you need to do your work over your VPN connections.

Setting up Shortcuts
This video tutorial shows you how to quickly set up VPN Shortcuts in VPN Tracker 365 and save them in your Connection Safe.

e®e@ & Web Browser @

Grace Miiller v VPN Connection:
VPN Tracker 365 VIP N

VPN Tracker World Cj

| ¢ SecureCorp HQ

| Q Search
VPN Shortcuts

VPN Shortcuts

Offices
(PRl
@ Oftceras ®
1. BB



https://www.vpntracker.com/us/backup-shortcuts.html%23shortcutstutorial

Connecting to a File Server

This video shows you how to easily access file servers over VPN using Shortcuts:

[\ File Server

VPN Connection: =€ Secure Corp VPN

Sara Hughes File Server: SMBJCIFS Server.
VPN Tracker 365 VIP.

ek facia Vs smb://  fileserverinternal.securecorp.net

BETA

(o8 o

Always disconnect when session ends
Q

VPN Shortcuts
VPN Shortcuts !

My Connections
(7)) Secure

@ venem © @
7P\ Madrid

@ Office =8 U@

¢ J ed@ @ O @

+- <] File Server Web Browser  Mail _FileMaker Pro Advanced Messages _Calendar Remote Desktop Screen Sharing MS Remote Desktop _ Terminal



https://www.vpntracker.com/us/work-from-home.html%23video_shortcuts

Managing your Connections
Locking Connections

You can lock a connection to prevent it from being modified (VPN > Lock Connection...). During this step, you will be asked to enter an unlock password which will need to be
entered should you or another user need to make changes in the future:

@ VPN Tracker365 File Edit m Tools View Window Help ingow  neip
[ NN Connect ®e
Grace Miller -~ ‘ | P You are about to lock the connection. The unlock
VPN Tracker 365 VIP Ol . g 5 Z
VPN Tracker World Connect s password will be required for editing the
Lock Connection... 0L connection after it has been locked. ler
Q 3
VPN Shortcuts E
Edit XAUTH Credentials...
SecureCorp Shortcuts Reset Network Conflict Resolution Unlock Password: [ |

Offices Confirm Password:

-, SecureCorp B
@ roEmm B

. Home D Don't Lock
Office B3 — 2 : PN

Madrid e (VD t
- “y _ v
J openvp

To prevent others from modifying connections you export for them, enable locking in the export settings.




Organizing Connections in Groups

@ 3

If you have a lot of connections, it will be useful to divide your connections up into groups, e.g. by client, by branch office, by geographical location etc.

To add a new group, click the ‘+" icon in the lower left hand corner of the window and select ‘New Group”:

Q IPsec
Q L
New Company Connection...

New World Connect Destination...
New VPN Shortcuts

You can drag & drop connections and VPN Shortcuts Collections between groups to rearrange them:

[ NN
@ Orace Mller @ Madrid Office
VPN Tracker 365 VIP
VPN Tracker World Connect m Connection Safe

Q e Not Connected

VPN Shortcuts

SecureCorp Shortcuts  HE m

Head Office This Mac Internet
SecureCorp -
Hommm X~ @ ()

Branches .
) gfa}%;d B ()
@ %)?fn;::" »

S B

Paris y
Office (8 @

Home

Home '
Office Lt @

17



To rename, delete or control a group of connections, use the gear menu on the right side of the group.

An exported connection knows the group it belongs to, and will recreate it as needed.

Searching Connections

™ 3

If you are a consultant or admin looking for a specific connection, use the search box at the top of the sidebar to find it:

[ NN )
@ Grace Milller @2 London Office
VPN Tracker 365 VIP 5 .
VPN Tracker World Connect ’ '
© Londor{_ ®)]  Not Connected
Branches

O Sioen ®

This Mac

18



VPN Connection Stats

When connected to your VPN, you can see statistics for your connection in the
sidebar.

The traffic graph lets you know how much data is currently being sent and received
over your VPN connection, as well as the total amounts of data transferred, and the
maximum throughput seen in the last measurement period.

It also lists the algorithms that are in use and the current network settings.

Menu Bar Item

You can also control VPN Tracker 365 directly from your menu bar, allowing you full
control over your VPN connection, without having to leave the application you're
working in:

A ™ Thu10:16

Show VPN Tracker [___-
VPN Shortcuts J
Head Office #? SecureCorp HQ

Branches
Home

Quit VPN Tracker

7...‘(m Network Security

I
Current: 41.7 KB/s
Total. 620MB arme
Peak: 29 MB/s 1200 Ki/s

+ B ics]

19



App Notifications

VPN Tracker 365 shows push notifications whenever something interesting happens to your VPN:

P e
k SecureCorp HQ has been disconnected

You may customize these notifications in “VPN Tracker 365" > “Preferences” > “Notifications”:

b'b—o Preferences

o B e

General Connection Safe Net Scanner Network

Notifications: [78 notifications enabled
Turn off all notifications

VPN Tracker Opened
VPN Tracker Quit
v VPN Connected
v VPN Disconnected
v VPN Error
VPN Status Changed
+ Scan Finished Internet
v About to Disconnect
v Secure Drop Download Finished
v Secure Drop Download Failed
v Secure Drop Delete Failed




Connection Actions

You can configure your VPN connection to carry out certain actions on launch. To get started, go to a connection, click “Configure” and go to “Actions":

’ SecureCorp HQ

Basic Advanced S{IEE Notes

Connect Automatically Connect this VPN when VPN Tracker is opened
Locations Automatically connect ("ON") or disconnect ("OFF") when switching locations:
Wi-Fi Networks Automatically (re)connect this connection in the following Wi-Fi networks:

Actions After Connecting

© [ |  Check All Email Accounts B 2 Test Now

Actions Before Disconnecting

(+] Disconnect Servers in this VPN B Timeout 10 Seconds ~ Test Now

Connect this VPN when VPN Tracker is opened

Enable this option to automatically connect to this VPN whenever VPN Tracker is opened.

Locations

If you use multiple network locations on your Mac (System Preferences > Network), VPN Tracker can automatically connect or disconnect your VPN connection, depending on
the current network location.

e Switch the slider to “On” to automatically connect in this location
e  Switch the slider to “Off” to automatically disconnect in this location

Wi-Fi Networks

With this action, VPN Tracker 365 will automatically connect to your VPN whenever your Mac connects to the wireless networks you have specified.

21



Actions After Connecting

VPN Tracker 365 can take care of any tasks that need to be performed after the VPN connects.

For example, if you always need to connect to a file server, enter it here to make sure it's available any time you connect the VPN. Or, if you want to open your company’s
intranet website whenever you connect, enter it here.

Actions can help you to be even more productive with VPN Shortcuts. For example, if you have certain applications in your VPN Shortcuts Collection that require a file
server to be connected, add that file server here to ensure that it's always available to your VPN Shortcuts items.

Actions Before Disconnecting

If there’s anything that needs to be done before the VPN is disconnected, add it here. VPN Tracker 365 automatically adds an action to disconnect all file servers that use the
VPN.

Notes
If you would like to make a few notes - for yourself, or for others that you're setting up this VPN for, the Notes tab is the right place:
[ JCN
G v D
STt ® SccureCopHQ
VPN Tracker World Connect Basic Advanced Actions
a Organization SecureCorp
VPN Shortcuts Reference # Reference Number

SecureCorp Shortcuts  [# E Sorah N
Contact  Sarah Hughes

Head Office Email  hughes@securecorp.com
SecureCorp - Phone  Phone Number
@ hoe=m B Website ~Helpdesk Website

< Connection Checker Notes  Sarah - Network Admin

Zeitpunkt Ethernet ¢+ Use connection to access SecureCorp HQ files and iMac in San Diego
Q@ rpsec
Q
Q@ openven

@ sonicwaLL ssL

Last checked § Sep 2010 at 17:34:54
Show Connection Checker ...
+- <]

Manage Team & Plans... Export Settings... Export...
e Notes are included with exported connections

e When exporting Accounting records, the reference number and organization can be included for use with billing systems
e Allinformation from the Notes tab is displayed on the Status tab



Connection Safe

What is Connection Safe? VPN Tracker 365 Connection Safe keeps your VPN connections safe and backed-up. Using state-of-the-art cryptography,
Connection Safe uses encryption to tie your connection to your personal equinux ID, so only you can access your connections.

Visit our website to

Saving a VPN Connection in the Connection Safe

Once you have set up a VPN connection in VPN Tracker 365, it is best practice to back the connection up in your Connection Safe. This way, you will not have to configure the
connection again if you get a new Mac.

To save a connection, right click on the connection in the sidebar and click “Add to Connection Safe ..."

@) raisofficetaEm (|
' Rename "Paris Office"..
Home Duplicate “Paris Office”
Home Delete “Paris Office"..

Office =
Add “Paris Office” to Connection Safe ...

Lock Connection...

) Connec|  Use Default Icon
Zeitpunkt Et  Choose Image...

Q@ ¢ Lt XAUTH Credentials...

@ 2 ghowLog ’
) oven  Generate Technical Support Report... in
@ sonic Reset Network Conflict Resolution ‘

Last checked 5 Sej EXDOl’t
Show Connection Checker .1



https://www.vpntracker.com/us/features.html%23connectionsafe

You can see whether or not a connection has been backed up if the Connection Safe icon appears next to it in the sidebar:

e0e
Grace Milller
VPN Tracker 365 VIP
VPN Tracker World Connect . I
& )
N
VPN Shortcuts 7
SecureCorp Shortcuts i I

Head Office .

-, SecureCorp o
@ voezm E;X

Backing up VPN Shortcuts in the Connection Safe

As well as VPN connections, if you have a VPN Tracker 365 Pro or VIP plan, you can also save your VPN Shortcuts to your Connection Safe. This allows you easy access to all your

most-used VPN workflows wherever you are working and means you don't have to configure new Shortcuts if you get a new Mac. Learn more about Shortcuts in — VPN

Shortcuts

Just as described above for saving connections, to add a Shortcuts Collection to your Connection Safe, right click on the collection and click “Add to Connection Safe ...”

Managing your Connection Safe

You can view the Connection Safe status of a particular connection, by opening the Connection Safe tab:

eoe
@ Grace Miller @ SecureCorp HQ log | Configure

VPN Tracker 365 VIP

VPN Tracker World Connect Status Connection Safe Net Scanner Accounting

o
VPN Shortcuts SynC
g
ame——— bf Last sync: Today at 12:20:15

Next sync: 12:39
Head Office

-, SecureCorj
@ faemn » O secure

Sync now

Remove from Connection Safe
Branches

Here you can add or remove connections to your safe and also sync your connection if you have made any changes.

VPN Tracker 365 syncs with your Connection Safe sync every 10 minutes.

24



Connection Checker

What is Connection Checker? Connection Checker automatically tests new network environments, figures out which VPN standards are supported

and optimizes your connection. Connection Checker quickly connects to VPN Tracker 365 servers and determines which settings to use for successful

VPN connections.

Visit our website to

Accessing the Connection Checker

To open the Connection Checker, go to the “Tools” menu and click “Open Connection Checker":

[

VPN Tracker 365 File Edit

VPN LS

r

&,

Alternatively, you can open and collapse the Connection Checker widget by clicking on the icon in the bottom left corner of the app window:

Grace Miiller
VPN Tracker 365 VIP
VPN Tracker World Connect

Branches

Home

+-

\1}3 nnection Checker
Madrid Office ¢+

@ rpsec
o OpenVPN
) sonicwaLL sSL

Last checked just now

Show Connection Checker ...

v —

Open Connection Checker...

View Window Help

X #EW

T w -
IMacISecUreCorpIICUStomEADatabase)

S

ISCISalesIpoTtall

25


https://www.vpntracker.com/us/features.html%23connection-checker

Performing a Connection Check

If you are experiencing difficulties with your internet connection or connecting to a new network for the first time (e.g. at a hotel or cafe), performing a connection check is the

best way to diagnose any network issues and determine whether the VPN protocol you need is supported.

Once you have the Connection Checker open, you will see your current network and a list of VPN protocols. Check the box next to the protocols you want to test, or check
“Select All" if you want a general overview. Click “Start Connection Check” to test the connection and identify which of the selected VPN protocols are supported.

[ JoX ] Connection Checker

@ Connection Checker

Test your internet connection's capabilities with the VPN
racker 365 Connection Checker.

Connection Checker JINENTRTIQRCE T ERIESEN TN

Name: | Madrid Office |
Last checked 28. May 2020 at 14:35:23

Summary o Summary

5 connections, 3 protocols.

| Protocols
S
2 connections

0 connections.

2 connections.

o

Your computer Gateway Connection
Checker

0000

T connection ) Aitested protocols should work.

Start Connection Check

@ Select All |

Under each protocol, you will see how many of your saved VPN connections use this protocol. Click on a protocol for more specific detail:

Name:  Madrid Office
Last checked 28. May 2020 at 14:35:23

Summary o IPsec
5 connections, 3 protocols
IKEV1 v ESP v NAT-T v
Protocols
Check successful, IPsec VPN connections should work.
{Psec] v
2 connections
= Connections that use IPsec:
L2TP o
0 connections Home Office Auto
o London Office Auto
2 connections

26



Troubleshooting unsupported protocols

VPN protocols which aren't supported are indicated by a yellow warning icon:
Protocols

g [ssc) A

1 connection

Tracking network locations
The “Network Locations” tab in the Connection Checker window is a useful reference to help you keep track of all your previously tested networks and their test results.

Connection Checker

\Q Connection Checker

Test your internet connection's capabilities with the VPN
Tracker 365 Connection Checker.

Connection Checker [INEUEIIREEIINY Settings

Current Network Location: Madrid Office

Connection Checker results for previously checked Network Locations:

Name ~ Gateway.. LastUpdate Results

Home Office 0:9f:c2... 27.05.20,14:42 | ([0 (IXENERN) KaT9

Madrid Office 28.05.20,14:35 |[ED

Adjusting your Connection Checker settings

You can configure Connection Checker in the “Settings” tab. Activating options such as “Auto test when connecting in new Network Locations” make your VPN workflow much
easier.

Connection Checker

@ Connection Checker

Test your internet connection's capabilities with the VPN
Tracker 365 Connection Checker.

Connection Checker  Network Locations

Auto test when connecting in new Network Locations

Auto test on startup or network change

Only protocols being used @ Al protocols
Ask to assign name for new Network Locations.

Show Connection Checker in Connection View

27



Network Scanner
(PRO]
The Network Scanner in VPN Tracker 365 Pro lets you explore the remote network of your VPN, assist users and easily locate available hosts

and services.

Scanning Networks

To scan a network, your Mac must be connected to the network via VPN.

e Select the VPN connection in the sidebar and start the connection.

e Go to the “Net Scanner” tab.
Click the “Scan” button in the bottom right corner to scan the network using a selection of the most popular network services:

[ ]
[ JCN J
Grace Miiller SecureCorp HQ Log Configure
VPN Tracker 365 VIP
VPN Tracker World Connect Status Connection Safe Accounting
Q
ST 8y Service
VPN Shortcuts _
Q =

SecureCorp Shorteuts [ g
Network Scanner

Offices
SecureCorp
L s (@

Branches soe
Start a scan

Home Find devices on your network.

Network  Security
v Network and services

Current t: 0 Byte/s
Total: 184.2 MB 407.6 MB
Peak: 645 Bytefs 306 Byte/s Select a network and choose the
services to be scanned.
A M \ 14 services
172.20.0.0/24 ‘8 m

+ & <

If you are connected to a VPN where all network traffic is sent through the VPN (Host to Everywhere), VPN Tracker 365 will ask you to specify the network that you would like to

scan.
Depending on the size of the network and your Internet connection, the scan may take a while to complete. You can continue working with VPN Tracker 365 while a scan is in

progress. You'll receive a notification when the scan is complete.
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Customizing Network and Services

By default, the Network Scanner scans for a selection of the most popular network services.

To select different services, click the settings icon and check or uncheck the services that you would like VPN Tracker 365 to scan
for:

e To turn OS detection* on or off, use the checkbox at the top of the settings.
To check/uncheck all services, hold down the Option key while clicking a checkbox.
To restore the default selection of services and networks, click the “Defaults” button at the top of the settings.

*What is OS Detection? The Network Scanner can detect the type of host (e.g. macOS, Windows, Linux, Network Equipment, Printers) from
the services that are available on that host.

e OS detection requires certain services to be included in the scan. If you uncheck a service that is required for OS detection, OS

detection will be unchecked as well.

Tip: At the bottom of the settings, you can change the network that is being scanned. Select one of the remote networks of the VPN, or enter
a custom range or IP address. The more addresses a scan includes, the longer it will take to complete.

 ENCETIT  sccounting

Scan for devices via ping and:

0S Detection

FILE SHARING
FTP 21

HTTP 8080
REMOTE ADMINISTRATION
SSH 22
ARD 3283
VNC 5900
RDP 3389
Telnet 23
DIRECTORY & MANAGEMENT
0S X Server 311
SNMP 161
SNMP 152
SNMP over TLS 10161

SNMP-Trap over TLS 10162

LDAP 389

Additional Services

1722000 / 24

Log Configure

(Defauits

EMAIL
__POP3 110
_IMAP 143
_IMAP over SSL/TLS 993
_ POP3 over SSL/TLS 995
_ SMTP over SSL/TLS 465
_SMTP 587
CHAT
__ Jabber 5222
IRC 6667
PRINTER
LPR/LPD 515
@ PP 631
DATABASES
MySQL 3306
FileMaker

108 WI-FI SYNC!
i08 Syne

4
14 services
xRl s}
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Scan Results

Using Scan Results

Connect to Services

You can connect to a service right from the Network Scanner, or open the app associated with this service on your Mac.

e Display the scan results "By Address” or “By Service”.

e On the right side, click the “Connect” or “Open” for the service or host that you would like to connect to:
@ SecureCorp HQ
Status connection safe [ AN Accounting
By Address |SM8| SMB (Windows File Sharing)
Q Searct =

{4 SMB (Windows File Sha.

W SMB (Windows File Sha.
FILE SHARING

Ry SV Windows Fie shar... @) m m
WEB

@ HTTP (Webserver)
80

Connect...
@ HTTPS (Webserve)

a43

Add to VPN Shortcuts Collection

e To add a service as VPN Shortcut, click the '..." button for the service that you would like to add to a VPN Shortcuts Collection.
e (Choose “Add to VPN Shortcuts” and select the VPN Shortcuts Collection that you want the service to be added to:

24 SMB (Windows File Sha...

s

Connect...

Add to VPN Shortcuts »

=i SecureCorp Shortcuts
Copy IP Address

Jump to Host
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Customizing Scan Results

Renaming Hosts

Renaming hosts in the Network Scanner list makes it easy to locate your most important computers and network devices.

e Display the scan results "By Address".
Right click the host you want to rename.
Choose "Rename” and enter a name:

@ SecureCorp HQ Log
= Status Connection Safe  [NERC TN Accounting
By Service [==5

Q =8
'WINDOWS = = —

[ termac-origin oot

Group »
- |

== SMB, HTTP, HTTPS, SSH, RDP

Choos:

Copy IP Address

Automatic Hostname Lookup

VPN Tracker 365 can automatically look up the hostnames for IP addresses in the Network Scanner. All you need is a Remote DNS server for your VPN that can provide host

names for the IP addresses that are being scanned (reverse DNS lookup). Make sure the checkbox “Use for reverse lookup of IP addresses in remote networks" (Basic > DNS) is

checked:
DNS Use Remote DNS Server
Receive DNS Settings from VPN Gateway
Use DNS Server for All Domains

v | Use for reverse lookup of IP addresses in remote networks (?

Setting a Custom Icon for a Host

e Display the scan results "By Address”.

e Right click the host you want to change the icon for and click “Choose icon...” to set a custom icon for this host.
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Change the OS Detection Group

The Network Scanner automatically detects the kind of host - whether it's macOS, Windows or Linux, or a printer or network equipment. OS detection uses the services on a

host to determine the most likely type of host. OS detection might put a host into a different group than what it actually is. You can change the group if a host is not detected
correctly.

Display the scan results "By Address”
Right click the host whose group you want to change.
e Select the new group from the “Group” menu:

LINUX : Open... . wee E Open... .
—m Rename
&, Ib-2.dmz. Mac 0S X
HTTP, HTTR i A i0sS
o Ib-3.dmz] Use Default Icon ineows
wrte, Hrre  Choose Icon... Printer
& Ib-4.dmz. Copy IP Address Network Equipment
HTTP, HTTP; 7 Unknown

TGP Bart 99

Resetting Scan Results

e Click "Reset Scan Results” in order to clear the results. Customized host names, icons, and groups will not be modified - if the host is encountered again in a future
scan, the customization will be applied.

e Hold down the Option key while clicking "Reset Scan Results” in order to also reset all customization (names, icons, and groups).

— oM, M1 IF, A1 IFD, RUF

TCP Port: 80
LINUX

w 1b-1
HTTP, HTTPS, HTTP, SSH

Open...

Reset Scan Results —
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Accounting
(PRO

If you have a VPN Tracker 365 Pro or VIP plan, you can use the Accounting feature to track the time you were connected to your VPN. It can
assist you with billing your clients and documenting your work.

Customize the Display

e To select the month for which data is being displayed, click the back/forward buttons next to the month.
e To select the columns displayed in the Accounting table, right-click the table header and check or uncheck the columns.

@ SecureCorp HQ log  Configure

Status Connection Safe Net Scanner
May 2020
Duration  Rounded Traffic - =
v Date
27. May 2020 at 15:08 Wednesday 2sec 025h  1ma3ke Y Weekday b kB
v Duration
27. May 2020 at 15:08 Wednesday 1 min 0,25h 030MB v Rounded 1kB
Local IP
Today at 14:34 Friday 2h 40 min 275h 581,95 MB VPN Gateway P [MB
27. May 2020 at 15:40 Wednesday 2min 025h 0,60 MB le’a"ic i MB
n
27. May 2020 at 15:27 Wednesday 1 min 0,25h 031MB v Out 1kB
+ Comment
27. May 2020 at 16:21 Wednesday 45 sec 025h 0,30 MB D

Add Comments

You can add a comment for every connection to your client's VPN. This helps you to keep track why you used the connection on this day and also makes billing easier:

Grace Milller / u Securecorp HQ Log Configure
VPN Tracker 365 VIP
VPN Tracker World Connect Status Connection Safe Net Scanner
Q
May 2020
VPN Shortcuts
SecureCorp Shortcuts  H¥ Duration Rounded Traffic In Out Comment
offi i 2 h 40 min 2,75 h 581,95 MB 192,03 MB 389,92 MB Updating customer database
ices
-, SecureCorp 27. May 2020 at 15:40 Wednesday 2 min 0,25h 0,60 MB 0,37 MB 0,23 MB
@ ra e @

]27. May 2020 at 15:27 Wednesday 1min 0,25h 0,31MB 0,24 MB 75,32 kB



Exporting Accounting Data

VPN Tracker 365 Pro not only tracks connection time for you, it also lets you export this data for Numbers or Excel, or to third-party time tracking or billing systems that can

import CSV files:

e  C(Click "Export” in the bottom right corner of the "Accounting” tab

e (Choose "Export for Numbers..." or "Export for Excel...” depending on with which application you want to use the data with
o To exportdatain a customizable CSV format, choose “Custom Export..."

Export As: I Accounting Data - SecureCorp HQ I

Tags: ‘
Where: [ Documents M
Connection: = SecureCorp HQ

Export range:

27. May 202( From:

27. May 202(

Today at 14:.

This Month (May)

1. 52020 0 To: 31. 5.2020 ¢

|

27. May 2020 at 15:40
27. May 2020 at 15:27
27. May 2020 at 15:21
27. May 2020 at 15:17

27. May 2020 at 14:43

Clear All

The export can include data for one or more connections, simply select additional connections from the “Connection” popup.

Wednesday
Wednesday
Wednesday
Wednesday

Wednesday

‘ it Scanner

Log Configure
Accounting

Duration Rounded Traffic
2 sec 0,25h 1113

1 min 0,25 h 0,30

2 h 40 min 2,75h 581,95
2 min 0,25 h 0,60

1 min 0,25 h 0,311

45 sec 0,25 h 0,30
44 sec 0,25 h 0,49
23 min 0,50 h 1,42

Export v

Reference Number and Organization: To integrate VPN Tracker 365's accounting with your own time tracking or billing system, an organization and a reference number can

be set for each of your VPN connections in the “Notes” tab of the configuration window.
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InfiniConnect
(PRO | VIP |

VPN Tracker 365 InfiniConnect (available in Pro & VIP plans) automatically detects connection interruptions and reconnects your VPN,
giving you peace of mind to focus on your work. This video shows you how it works:

Visit our website to
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https://www.vpntracker.com/us/infiniconnect.html%23video
https://www.vpntracker.com/us/features.html%23InfiniConnect

Exporting Connections
@ 3

Whether you're quickly exporting a VPN connection for a coworker, or rolling out VPN Tracker 365 to hundreds of users, VPN Tracker 365's
sophisticated export and convenient installer is there to help.

Exporting a Connection

Once you have set up and tested a VPN connection, you can export it for other VPN Tracker users.

To export a connection

e Select the connection
e (Choose “File" > “Export™

[

VPN Tracker 365 [NJlEH Edit VPN Tools View Window Help

00 New >
Grace Miiller scureCorp HQ
@ VPN Tracker 365 vip  IMPOTt L ‘ p
VPN Tracker World Co_ Migrate »> [ staws |

Export... BE
Q d
Close Window ~ #W

VPN Shortcuts

SecureCorp Shortcuts  H¥

Offices This Mac 1

@ SecureCarp s @

HQ CZE

e The export window will now open. If you are exporting a connection for users of previous versions of VPN Tracker 365, be sure to select the appropriate file format
from the “Export File Format” menu:

Export As: | SecureCorp HQ |
Tags:
Where: [ Documents o -
Export File Format VPN Tracker 365

Imnart Paceward



Not all features are available in previous versions of VPN Tracker. When exporting for earlier versions of VPN Tracker, we recommend testing the exported connection in the
respective version before rolling it out to end users.

e We recommend you make your export more secure by setting an encryption password for the file. Users of this connection will be required to enter the password once
when importing the connection, so be sure to keep a record of the password you choose.

Export As: ‘SecureCorp HQ \

Tags: | ‘
Where: | [ Documents g v
Export File Format VPN Tracker 365

Import Password

Exported connections are encrypted. The password will be
required to import this connection.

Import password: eeeeeesseee

Confirm import password: -

Remote Connection Wipe

Remote Connection Wipe is not enabled for this

 Cancel

To export multiple connections in a single file, select the connections you would like to export (hold down the 3£ key to select more than one), and choose File > Export....
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Exporting a VPN Shortcuts Collection

You can also export VPN Shortcuts Collections for your users, along with their connections. Simply select the Shortcuts Collection in the sidebar - along with any VPN
connections you wish to export - when exporting (hold down the £ key to select more than one item in the sidebar):

Grace Miiller v
VPN Tracker 365 VIP

VPN Tracker World Connect
Q

VPN Shortcuts

SecureCorp Shortcuts {5
offices

’ SecureCorp B .

HQ CZ=E0 -

VPN Tracker
< Connection Checker

Madrid Office ¢+
@ e

@ ur

@ openven

@ sonicwaLL ssL

Last checked 6 days ago.

1 connection
and 1 VPN Shortcut collection selected.

Show Connection Checker ...
+- icq]

In the Export Settings, you can choose to automatically export a Shortcuts collection alongside a VPN connection. This helps end users gain access to their most important

VPN services faster.

Pre-Shared Key | Include pre-shared key from keychain
Permit pre-shared keys to be stored in and loaded from the keychain

Extended Authentication (XAUTH) Include XAUTH login and password from keychain
Permit XAUTH credentials to be stored in and loaded from the keychain

Connection Safe Let user decide

Security Remote Connection Wipe
Restrict this connection to your team members and enable Remote Connection Wipe

Last updated Today, 15:48:17
Don't allow settings to be changed
de set d detailed log:
inlock passwor
Unlock password «+-+--
Confirm unlock password

VPN Shortcuts SecureCorp Shortcuts

Actions Include actions.

Contactinfo helpdesk@example con
This email address is the default recipient for Technical Support Reports

Close
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Export Settings Explained

VPN Tracker 365 provides admins with a large amount of configuration options for when you choose to export a VPN connection for team members to work with. Access these settings by
heading to the “Configure” tab of your connection and clicking “Export Settings” at the bottom of the window:

P SecureCorp HQ

Basic Advanced Actions Notes

Network Configuration Push/Pull 2
Protocol OpenVPN
Topology Host to Network 2
Authentication TLS >)mcinnes

User Username + Password - Stored in keychain

DNS Use Remote DNS Server
Receive DNS Settings from VPN Gateway
Use DNS Server for  All Domains <
vJUs ook > add e netv 2

Manage Team & Plans... Export Settings... Export...

Pre-Shared Key

Pre-Shared Key Include pre-shared key from keychain
The included pre-shared key will be added to the user's keychain.
Permit pre-shared keys to be stored in and loaded from the keychain

Include pre-shared key from keychain

If you have saved the pre-shared key in your keychain, VPN Tracker 365 can include this pre-shared key with the exported connection.

Permit pre-shared keys to be stored in and loaded from the keychain

Checking this option will (a) move an included pre-shared key into the user’s keychain when importing the connection, and (b) permit users to store their pre-shared key in the
keychain if none is included with the exported connection.
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Extended Authentication (XAUTH)

Extended Authentication (XAUTH) Include XAUTH login and password from keychain

The included XAUTH credentials will be added to the user's keychain.
Permit XAUTH credentials to be stored in and loaded from the keychain

Include XAUTH login and password

If you are using Extended Authentication (XAUTH), you can also include a user's XAUTH credentials (username and password) in the exported connection. Select whether you
would like to include the username and password stored in your keychain, or be asked for an XAUTH username and password when exporting the connection.

Permit XAUTH credentials to be stored in and loaded from the keychain

Checking this option will (a) move included XAUTH credentials into the user’s keychain when importing the connection, and (b) permit users to store their XAUTH password in
the keychain if none is included with the exported connection.

Connection Safe

Add to Connection Safe automatically
Connection Safe v Let user decide
Prevent adding to Connection Safe

Here you can choose from the options to determine whether or not you want the VPN connection to be stored in the user's Connection Safe.
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Security

Security Remote Connection Wipe
Restrict this connection to your team members and enable Remote Connection Wipe

Secure Corp
Last updated Today, 16:03:15

v | Don't allow settings to be changed
Hide settings and detailed logs

Permit editing with unlock password
Unlock password «««««««-

Remote Connection Wipe (Recommended)
This setting gives you the ability to remotely wipe the VPN connection from a user’s account (including the Connection Safe) - i.e. if they leave the company or lose their Mac.

Don’t allow settings to be changed

This setting prevents users from making accidental or undesirable changes to their VPN connections. The connection is “locked”. Users will be able to see the connection
settings, but will not be able to modify them.

Hide settings and detailed logs

Hides the Basic and Advanced tabs, as well as the more detailed log levels. Only basic logging and troubleshooting information is displayed. Technical Support Reports cannot
be created unless an unlock password is set.

Temporarily permit editing with unlock password (Recommended)

With an unlock password, the connection can be unlocked temporarily, for example if an administrator needs to make changes at a user's computer.

If you don't set an unlock password, there will be no way to ever make any changes to the exported connection or use a Technical Support Report to analyze a technical
problem.
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VPN Shortcuts

VPN Shortcuts SecureCorp Shortcuts

If you have configured a VPN Shortcuts Collection, you can choose to include it with your exported connection.
Use a VPN Shortcuts Collection to access all the services they need VPN for - network shares, internal websites, databases, and applications.

VPN Shortcuts selected here are always included when exporting this connection. If you'd like to export additional VPN Shortcuts, simply select them together with your
connection before exporting.

Actions

Actions Include actions

If you have configured actions to be executed when the connection is connected or disconnected, you can include them as well. Any settings you have configured in your
connection’s “Actions” tab will be included.

Contact info

Contact Info helpdesk@securecorp.com
This email address is the default recipient for Technical Support Reports

If your VPN users run into any issues, they can email you a Technical Support Report with details about their connection settings, local internet connection and VPN logs. The
email address you enter as your contact info will be set as the default recipient of the report.
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Other Day-to-Day Considerations

Unlock Password

Experience has shown that when exporting a locked connection, you'll want to unlock it at one point or the other - whether it's making a quick change at an end user's Mac,
accessing an end user's Technical Support Report, or even importing the (locked) connection onto your own Mac and accidentally replacing the (unlocked) original.

e If you do not set an unlock password for a locked connection, there is no way to ever change settings.
e If you do not set an unlock password and hide the settings and logs, there's no way to ever access the settings.

Certificates

If your connection uses certificates for authentication, keep in mind that the certificates are not included with the exported connection. You'll need to distribute the certificates
as you would normally do.

VPN Tracker 365 will automatically attempt to use the same certificates on the Mac where the connection is imported. If they are not available, the user will be prompted to
select new certificates.

Overwriting Existing Connections

If you have made changes to a connection that you have already distributed to your users, it's a good idea to reuse the same connection when exporting (instead of creating a
new one).

That way, your users will be prompted to replace their existing connection with the updated one, instead of ending up with another copy, and in the end not knowing which
connection is the current one.
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Troubleshooting

Missing Settings

If you forgot to fill in a setting, VPN Tracker 365 will point it out to you:

’ VPN to SonicWALL NSA Series (SSL VPN)

Basic = Advanced Actions Notes

afrar]n
CIsCO

C ion Name VPN to SonicWALL NSA Series (SSL VPN)
Connection based on (=) Cisco ASA 5500 Series

Configuration Guide

VPN - 7 l> Please enter the host name or public (WAN)
. IP address of your VPN gateway.

Connection Errors

In case of any other problem, a yellow warning triangle will show up:

Offices e

® e 4 @

Click on the yellow warning triangle to be taken to the log. The log will explain exactly what the problem is. Follow the steps listed in the log to resolve the problem.
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[ JON ]
Grace Miiller
VPN Tracker 365 VIP
VPN Tracker World Connect

A} SecureCorp HQ

Log Configure

Status Connection Safe Net Scanner Accounting

ropprgwovae

o B L ]
Userlnfo={NSUnderlyingError=0x7ff3ddc295e0 {Error Domain=VPNTCoreDNSResolver Code=-65568

Q
“(null)“}
VPN Shortcuts 16:28:30 VPN Gateway Not Found
SecureCorp Shortcuts VPN Tracker was unable to find a VPN gateway with the specified host name, because the host name could
not be resolved (translated into an IP address).
Offices Please do the following:
" a%;:p A . - Check the VPN gateway's host name for typos
If you made sure that the hostname is correct, there might be some problem with your DNS server:
Branches
- The DNS server has no record for the specified host name. If you use a service like DynDNS, please make
Home sure your dynamic host name points to your VPN gateway's current IP address. Otherwise, please talk to
your network administrator
- The DNS server is configured incorrectly on your system. Please check your System Preferences (Network
@ Connection Checker panel)
No connection ¢+ - The DNS server is temporarily unreachable, refuses connections or is very slow. If the problem persists,
contact your Internet Service Provider
o IPsec
L2TP
o 16:28:30 About to Disconnect (Error)
& openven
@ sonicwaLL ssL 16:28:30 Not Connected
Last checked 6 days ago.
Show Connection Checker ... Log Level: Simple Email log... Technical Support Report (TSR)...

+- <1

Press Cmd-L to open the log in a new window. That way, you can have the log side-by-side with your VPN configuration window while making changes to troubleshoot a
problem.

If you need additional help, you can email the log to your administrator, or send a Technical Support Report (TSR) to equinux or to your network administrator. This contains the
settings and logs necessary for resolving technical problems. Confidential information (e.g. passwords, private keys for certificates) is not included in the TSR.

You can use the dropdown menu at the bottom of the “Log” window to change the level of the log depending on how complex the issue is:

16:28:3 o= sssmnnect (Error)
16:28:3¢ Medium I
Advanced
Verbose

Log Level: Simple a
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No Access to the Remote Network

If your VPN appears to be connected, but you cannot access resources (servers, email, etc.) in the remote network, check the following points to resolve the problem.

Connect to an IP address (instead of a host name)

If you are using a host name (e.g. fileserver.example.com) to connect to the resource, please try using its IP address instead.

If the connection works when using the IP address, but not when using a host name, please make sure that your Mac's DNS server is able to resolve this host name to an IP
address, or set up a suitable remote DNS server in VPN Tracker.

Check that the IP address you are connecting to is part of the VPN's remote network

Check that the IP address you are connecting to is part of the remote network(s) of the VPN. Also double-check the network mask that you have configured for the remote
network(s) in VPN Tracker 365. If you're using SonicWALL Simple Client Provisioning or Cisco EasyVPN, the remote network(s) are assigned by your VPN gateway. You can see
these on the Status tab.

Make sure the host you are trying to reach knows where to send replies
Start with checking if your local address is part of the remote network:
e Connect the VPN

e Go to the Status tab
e Compare the IP address listed under “This Mac” (local address) and the networks listed under “Remote Network”. Is the local address part of the remote network(s)?

This Mac Internet VPN Gateway Remote Network
192.168.213.189 DELL SonicWALL TZ 210 192.168.213.0/24
vpntest.equinux.net
194.145.236.73 -
-

In this example, the local address 192.168.213.189 is part of the remote network 192.168.213.0/24
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If the local address is part of the remote network(s):

There are exactly three setups where the local IP address may be part of the remote network(s). If your setup is not one of these, you must choose a local address that is not
part of the remote network(s).

1. When connecting to a SonicWALL using SonicWALL Simple Client Provisioning or DHCP over VPN.
2. When connecting to a Cisco VPN gateway using Cisco EasyVPN.
3. When connecting to a VPN gateway that can act as an ARP proxy for IP addresses assigned through Mode Config, and/or for fixed local addresses.

That third one is a bit tricky to figure out. If you find a reference to ARP Proxy (or Proxy ARP) in the device's documentation, or if the manual specifically instructs to choose the
local address or the Mode Config address pool to be part of the remote network, then it's ok for the IP address to be part of the remote network.

In all other cases you must choose an IP address as the local address (or a Mode Config address pool) that is not part of the remote network(s). If you are using Mode
Config, you need to change the Mode Config address pool on the VPN gateway. Otherwise, simply change the local address in VPN Tracker (Basic > Local Address).

If the local IP is not part of the remote network(s):

Check if your VPN gateway is the default gateway (router) of its network.

If your VPN gateway is not the default gateway of the remote network, you will have to ensure that responses to all IP addresses used by VPN clients are routed to the VPN
gateway. You can do so either by adding a general route on the network’s actual default gateway, or by adding individual routes on each host that VPN clients need to
communicate with.
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Troubleshooting Remote DNS

If you can access resources on the remote network using their IP addresses, but not their host names, you will need a suitable remote DNS setup.

Prerequisites for remote DNS:

e A DNS server that is able to resolve those IP addresses exists.
e The DNS server can be reached through the VPN.

To illustrate the steps for debugging remote DNS issues, here’s an example setup using remote DNS:

We have a VPN connection to the remote network 192.168.42.0/24.

In this network, there's a file server fileserver.example.com.

We can reach this file server using its IP address 192.168.42.10.

We'd like to reach this file server using its host name fileserver.example.com.

This host name cannot be looked up using public DNS servers, but there is an internal DNS server with IP address 192.168.42.2 that is able to resolve hosts in the
example.com domain, including fileserver.example.com.

DNS Use Remote DNS Server
Receive DNS Settings from VPN Gateway
DNS Servers  192.168.42.2 ?

Search Domains

+ N+

Use DNS Server for Search Domains
Use for reverse lookup of IP addresses in remote networks ?

For remote DNS settings to take effect, the VPN needs to be reconnected. We should now be able to connect to fileserver.example.com using its host name.

If you set a remote DNS server for “All Domains” instead of specific “Search Domains”, make sure it is a working DNS server that can resolve hosts on the Internet.
Otherwise, your Mac will seem to be cut off from the Internet when the VPN is connected.
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Steps to Troubleshoot

If connecting using the host name does not work, the first step is to use the DNS Lookup Tool to verify that the host name can be looked up.

e (Connect the VPN, Go to “Tools” > “DNS Lookup” in the menu bar on top of the screen
e Enter the host name (here: fileserver.example.com) and click “Lookup”

[ XC) DNS Lookup

[Qv fileserver.example.com| Q] o

> Details

If the DNS Lookup Tool displays the expected result, remote DNS is configured correctly. In that case, the problem is with the actual connectivity, not DNS. If DNS lookup fails,
then the problem is with remote DNS.

The next step is to figure out if the problem is with the remote DNS server itself, or with the remote DNS setup.

e Open a Terminal window (Applications > Utilities > Terminal)
e Enter: dig <host name> @<remote DNS server> and press return. In our example: dig fileserver.example.com @192.168.42.2

If you see an “Answer Section” with the correct IP address, then both the connectivity to the DNS server, and the DNS server's response are ok. In that case, the problem lies with
the remote DNS setup. Double-check the configuration in VPN Tracker 365.

# dig fileserver.example.com @192.168.42.2

3 == DiG 9.7.6-P1 <<= fileserver.example.com @192.168.42.2

33 global options: +cmd

33 Got answer:

33 ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 38186

53 flags: gqr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: @, ADDITIONAL: @

35 QUESTION SECTION:
;fileserver .example.com. IN A

33 ANSWER SECTION:
fileserver.example.com. 3600 IN A 192.168.42.10

53 Query time: 879 msec

If you don't see an “Answer Section” with the correct IP address, then the remote DNS server is not configured to resolve fileserver.example.com. If you get a timeout error, then
the remote DNS server is not reachable over the VPN or it is not a properly configured DNS server.

51



Managing VPN Tracker 365 Plans

The VPN Tracker 365 service allows you to easily view and update information regarding your VPN Tracker 365 plan online. It also has all the

necessary tools in place for network admins to successfully set up and manage multiple plans for a team of VPN users.

my.vpntracker.com

All VPN Tracker 365 plans can be managed via
and assign plans to users.

. Here you can view your current VPN Tracker 365 plan, access your Connection Safe, and also create a team

To get started, log in to the secure online portal using your equinux ID and password

Managing your personal account
After logging in to my.vpntracker, the first thing you will see is the VPN Tracker 365 plans that are currently assigned to you:

MY VPN TRACKER
l Products
Active Devices
Payment methods
Invoices

Account

& Download VPN Tracker

my.vpntracker.com

‘ Under the “My VPN Tracker” menu on the left, you can view all information
associated with your personal VPN Tracker 365 account. Here you can also:

e View the validity period of your VPN Tracker 365 plan and manage your
renewal preferences on plans you have purchased

e  Keep track of your active devices and remove any devices which are no
longer in use
Manage your payment methods

Assigned plans

Valid until 09. May 2021

Team: quinux staff [T equinux

1x VPN Tracker World Connect

Valid until 16. July 2021

Team: equinux staft (T equinx

Access and download your past invoices
e Make changes to your account (i.e. update your equinux ID)

To manage your VPN Tracker 365 team(s), go to the “Team Management” tab.
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Team Management

To set up a new team or manage an existing team, go to the Team Management tab:

my.vpntracker.com

el
[ . i iimen. [ & -

PRODUCTS TEAM MANAGEMENT SAFE FAQ DOWNLOADS LOGOUT

Creating a VPN Tracker 365 Team

Creating a VPN Tracker 365 Team is the best way for network admins to manage multiple plans and users. To get started, enter a team name and click on “Create Team™:

PRODUCTS TEAM MANAGEMENT SAFE FAQ DOWNLOADS LoGouT

NEW TEAM

Create a team to manage VPN Tracker products and users within your organization.

Name { SecureCorp

You will now have the opportunity to start building up your team and inviting new members.
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Inviting team members

To add members to your team, all you need to do is enter their email address and click “Invite”:

MANAGEMENT

Name Email

The invited team member will then receive an automatic email invitation with a personalised link to click on and join your team.

Tip: Each VPN Tracker 365 user needs their own equinux ID. After the user receives a team invitation from you and clicks the invite link, they can either create a new equinux ID or log in
using their existing account.

This video provides more information:

e®e® < > M & my.pntracker.com ] (U]

Metabase MD365 Analytics  Mail Designer..igner for Mac ~ Google Docs  Google Sheets  Dashboard « ..— WordPress dict.cc | War..lisch-Deutsch  Todos - Dashboard - GitLab  Beautiful Fre...es | Unsplash  Buffer >
My VPN Tracker

my.vpntracker.com

. ERX ""“Ol

Team invitation

Sara Hughes
meinnes+24@equinux.com
Sign out

You have been invited to join the team Secure Corp.

Accept invitation [ Switch to a different account ]
N
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Assigning VPN Tracker 365 plans to users

If you have purchased multiple VPN Tracker 365 plans for your team, you can assign each plan to a user so your colleagues can use VPN Tracker 365 on their Macs. You can
purchase additional plans at any time from the

Available plans will show up on the left of the window:

PRODUCTS TEAM MANAGEMENT SAFE FAQ DOWNLOADS LOGOUT

=AM Team Secure Corp

I Masage ® Team Management & Remote Connection Wipe guide

Settings ® Team invitation instructions

GROUPS MANAGEMENT

AVAILABLE PLANS
1« VPN Tracker 365 Pro

¥ Add VPN Tracker products

Manage

Team member Plan Actions
Rosa Lawson
'
World Connect
Grace Miller Valid until 9 May 2021 R
g e product is automatically

assigned to you.
Valid until 15 July 2021

Assign a plan to a user by clicking “Assign plan” and choosing an available plan from the dropdown list. If no plans are available, you will be notified and can proceed to purchase
more VPN Tracker 365 plans from the Team Store.

You can keep track of which users have been assigned which plan under the “Team Members” list. In this area, admins can also manage your team members’ plans.

Team member Plan

Actions
# Change plan...
Rosa Lawson VPN Tracker 365 Pro
Valid until 4 July 2020 © Suspend & Wipe...
2x Remove member...

Remember that a VPN Tracker 365 plan is assigned to a user for a specific device. Sharing of accounts and simultaneous use of multiple devices is not permitted in any way.
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Managing plans in your team

If you need to upgrade a user to a different plan option (e.g. from VPN Tracker 365 Standard to VPN Tracker 365 VIP), you can do this by clicking “Change plan...” The duration of
the user’s original plan will be available for you to assign to another team member if required. Here you can also revoke a VPN Tracker 365 plan if you made a mistake, or if the

user doesn't need the plan any more:

Choose Plan...
Revoke all
Pl Actions
Plans
# Change plan...
VPN Tracker 365 Pro
@ Suspend & Wipe...

Val Valid until 4 July 2020

'® Get more plans

Vallounmrymayzvzr————————

2 Remove member...

If a user leaves your team or does not need their VPN Tracker 365 plan any more, you can easily remove this user and revoke access to their plan. By clicking “Remove member”,
any connections the user has which are locked to your team will be automatically wiped from their account and associated devices.

If you suspect a security breach is possible (e.g. a team member’'s MacBook has been lost or stolen), you can remotely wipe the connection from their device. Just click "Suspend
& Wipe" next to the user in the team member list.

Team Settings

You can access your team'’s settings in the "Settings" section, found in the left sidebar of the "Team Management" tab.
Here you can:

e Rename ateam,
e  Export a list of team members for your records,
e Delete your team permanently
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Creating groups for your team

If you have many users in your team, it helps to create groups. For example, you could set up a group for all colleagues from marketing or other departments in your company.
Tip: When using VPN Tracker 365 VIP plans, you can also lock a connection to certain groups to use the Remote Connection Wipe functionality.

To create a group, go to the "Team Management" tab and click "Manage" in the "Group" section. Click "Create Group..." and enter a group name:

New group

Use Groups to restrict a VPN connection to a subset of your Team. Activate Remote
Connection Wipe when you export your connections in VPN Tracker.

Name

Group name

Adding users to a group
After you have created your group, select the group by clicking its name. Click "Add members..." You will now see a list of all available team members to add to the group:

Add members

Select the team members you want to add to the group.

Grace Muller

Rosa Lawson
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Using the Remote Connection Wipe function

All VPN Tracker 365 plans allow you to use VPN connections that are connected to a certain group and can be remotely removed from all team members' computers. This helps
you prevent unauthorized VPN access.

Follow these three simple steps to set up Remote Connection Wipe

1. Setup a connection and lock it to your team or a specific group
2. Export a connection and distribute it to your team
3. Suspend users from a team and remotely delete all locked connections

Set up a VPN connection that is locked to a certain group
After you have configured your VPN connection, you can enable the Remote Connection Wipe functionality for this connection.

Select your connection from the left sidebar

Click "Configure" and open the "Export Settings..."

In the section "Security" tick the option "Remote Connection Wipe"
Tick your team or the groups you want to lock the connection to:

HwnN =

Security Remote Connection Wipe
Restrict this connection to your team members and enable Remote Connection Wipe

Secure Corp
| Secure Corp: Marketing
Last updated Today, 14:41:37

v| Don't allow settings to be changed
Hide settings and detailed logs
Permit editing with unlock password

Unlock password ««««««««
Confirm unlock password ««««««-«

5. Click "Close" to save your changes
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Export your locked connection and share it with your team

Once you have enabled the Remote Wipe Connection functionality for your VPN connection, export your connection and distribute it to your team.

To do so

1. Choose your connection from the left sidebar in the VPN Tracker app
2. Choose "File > Export" from the top menu bar
3. Setan exportlocation and enter an import password for maximum security:

Export As: ‘SecureCorp HQ ‘

Tags: ‘
Where: [ Documents (&
Export File Format VPN Tracker 365

Import Password

Exported connections are encrypted. The password will be
required to import this connection.

Import password: eeeeeeeee

Confirm import password:

Remote Connection Wipe

This connection can be used by VPN Tracker
365 plan users in the following Teams: Secure

Edit...

4. Click "Export"
In the export window you will also see a short message that this connection is locked to your team or a group. Click "Edit..." for faster access to the security export settings.

You can now send the exported connection to your team member. All they have to do is to double click the file and to enter the import password (if you have one.) The
connection is then available in VPN Tracker 365 and ready to use.
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Suspend users and remotely delete connections

Everything is now set up so you can suspend and remove users from a group and remotely wipe all locked connections if necessary. In order to suspend and wipe, please follow
these steps:

Log in to https://my.vpntracker.com using your equinux ID and password.
Open the "Team Management" tab.

Click "Suspend & Wipe..." You will see a popup confirmation window.
Now, click "Suspend & Wipe Connections". The suspended user will then appear under the list “Suspended” where they can be removed or reinstated at any time:

HwnN -

Suspended

Rosa Lawson

&+ Reinstate member...

Please note that this will wipe all connections the user has that are locked to their team, as well as any groups from their computer.
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Managing Payments and Subscriptions

Besides managing and assigning VPN Tracker 365 plans, you can also manage subscriptions and payments, change subscription renewal settings, or download invoices for your
purchases via my.vpntracker.

Open the "Account" tab and click "Payment Methods" in the left sidebar:

MY VPN TRACKER
I Products

Active Devices

Payment methods

Invoices

Account

Here you can enable or disable the auto-renewal for subscriptions and see further details like the credit card that will be used to renew your subscriptions.

Click "Invoices" in the left sidebar to access all the invoices for your equinux ID. Even for non VPN Tracker 365 purchases:

MY VPN TRACKER

Products Invoices

Active Devices Your orders and invoices will appear here.

Payment methods
Invoices

Account
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Managing your Connection Safe
my.vpntracker also lets you access and modify your Connection Safe. In the “Safe” tab, you can view all of your stored VPN connections and Shortcuts:

SAFE

Connections n }‘f: 5 @ Secured connections

Shortcuts

Berlin Office

Last successful sync: 28 May 2020, 10:09
Updated: 28 May 2020, 10:09

London Office
Last successful sync: 28 May 2020, 10:09
Updated: 28 May 2020, 10:09

Click the "Delete” button to permanently erase a VPN connection or VPN Shortcuts from your Connection Safe and all of your Macs. Please note, this action cannot be reversed.
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